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Rendering dengan Enscape

Gambar 1 Hasil Rendering Interior dengan Menggunakan Enscape

Perkembangan teknologi dalam bidang perangkat lunak dan perangkat keras telah menghasilkan
kemajuan yang sangat signifikan untuk membantu pekerjaan manusia. Salah satu hasil dari
perkembangan teknologi tersebut adalah dalam bidang rendering dan animasi.

Enscape adalah sebuah software yang dapat kita gunakan untuk membantu proses rendering secara
real-time dan untuk media Virtual Reality. Software ini nayak digunakan dalam bidang Arsitektur,
Teknik, dan Konstruksi. Software ini dikembangkan oleh Enscape GmbH, yang didirikan pada tahun
2013 dan berpusat di Karlsruhe, Jerman dengan kantor di New York, Amerika Serikat. Pada tahun
2022, pengembang Enscape, Enscape GmbH, bergabung dengan Chaos, pengembang perangkat lunak
rendering pesaing V-Ray.

Persyaratan sistem Enscape

Pada saat tulisan ini dibuat, Enscape tersedia untuk Windows 10 atau versi yang lebih baru dan Mac.
Untuk versi yang didukung saat ini, kita dapat melihatnya pada laman website Enscape.

Enscape pada dasarnya menggunakan teknologi Ray Tracing untuk rendering Real-time sehingga
sangat bergantung pada kartu grafis (GPU) yang kita miliki untuk merender model 3Dimensi dengan
cepat. Oleh karena itu, kita memerlukan kartu grafis yang cukup kuat agar Enscape dapat berjalan
dengan lancar. Kita memerlukan kartu AMD atau NVIDIA dengan setidaknya 4GB VRAM khusus (tidak
dibagi).

Sebaiknya selalu perbarui driver kartu grafis untuk memastikan Enscape dapat berjalan lancar. Kita
dapat melakukannya melalui situs web NVIDIA atau AMD.

Berikut ini tautan untuk memperbarui driver kartu grafis:

e NVIDIA
e AMD



https://www.nvidia.com/download/index.aspx
https://www.amd.com/en/support
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Cara mengunduh dan menginstal Enscape untuk SketchUp

Untuk menginstal Enscape, Kita memerlukan Enscape Installer. Berkas file instalasi ini akan dikirimkan
kepada Anda melalui email jika Anda telah mendaftar untuk uji coba gratis, telah mengajukan
permohonan lisensi pendidikan , atau jika Anda telah membeli lisensi Enscape.

Sebelum menjalankan file instalasi, tutup SketchUp terlebih dahulu, kemudian mulailah menjalankan
file instalasi dan ikuti petunjuknya.

Membuka Enscape di SketchUp

Enscape adalah plugin render SketchUp (juga tersedia untuk alat pemodelan populer lainnya,
termasuk Revit) yang menyediakan akses langsung ke visualisasi waktu nyata dan realitas virtual bagi
desainer. SketchUp akan secara otomatis mendeteksi bahwa Enscape tersedia setelah Anda
menginstalnya.

Enscape dapat ditemukan di bawah ' Extensions' pada bilah alat SketchUp. Anda dapat mengakses
fitur-fitur Enscape di sini, atau Anda dapat membuat bilah alat Enscape terlihat dan, oleh karena itu,
lebih mudah diakses. Untuk melakukannya, klik kanan pada bilah alat SketchUp dan pilih 'Enscape’
atau buka View > Toolbars lalu pilih 'Enscape’.

Untuk meluncurkan Enscape pertama kali, masuklah ke akun pengguna Anda. Buka Extensions >
Enscape > About dan masuklah. Kemudian kembali ke Extensions > Enscape > Start Enscape.
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Cara memulai Enscape dan merender di SketchUp

Setelah Anda memasang Enscape dan membuka bilah alat, saatnya untuk mulai merender di SketchUp.
Buka berkas proyek SketchUp Anda. Jika Anda tidak memiliki berkas proyek, Anda dapat mengunduh
contoh proyek gratis dari situs web Enscape.

Selanjutnya, klik tombol ‘Start Enscape' pada bilah alat Enscape (atau buka Ekstensi > Enscape > Start
Enscape).
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Enscape akan terbuka di jendela baru, dengan proyek Anda secara otomatis ditampilkan dan
dipresentasikan dalam tampilan perspektif. Pada tahap ini, Anda dapat mulai menjelajahi model yang
telah dirender.
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Sekarang kita akan menikmati enscape yang menyenangkan! Cobalah menukar material, mengubah
geometri, atau menambahkan aset. Saat Anda menyesuaikan proyek di SketchUp, Anda dapat melihat
perubahan langsung muncul di Enscape (jika Anda mengaktifkan Live Updates di Enscape). Anda juga
dapat mengaktifkan ' Synchronized Views ' untuk menyinkronkan tampilan perspektif dari SketchUp ke
jendela rendering Enscape. Sekarang, saat Anda menavigasi model SketchUp, Enscape akan mengikuti
dan menyajikan tampilan yang sama.

Menu Bantuan Enscape

Enscape menyediakan Menu Bantuan untuk membantu Anda menggunakan plugin. Untuk
mengaksesnya, tekan tombol H atau tanda tanya di kanan atas jendela Enscape Anda. Bergantung pada
fitur yang Anda gunakan, Anda akan melihat petunjuk dan kiat yang sesuai ditampilkan.

Misalnya, saat berada di pengaturan 'View Management', Anda dapat menemukan petunjuk tentang
cara menelusuri proyek Anda. W untuk maju, S untuk mundur, A dan D untuk bergerak ke kiri dan kanan.
Bahkan informasi tentang cara mengubah waktu, menelusuri atau terbang di proyek Anda, dan
mengubah sudut dan rotasi matahari.

Kiat-kiat bermanfaat ini akan berubah saat Anda menjelajahi Enscape dan membuka berbagai fungsi.
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Menemukan jalan di Enscape

Merupakan praktik yang baik untuk menyiapkan tampilan di awal proyek Anda sehingga Anda memiliki
titik referensi yang selalu dapat Anda kunjungi dan lacak kemajuan dokumen.

Di jendela render Enscape, tekan F pada keyboard Anda setiap kali Anda ingin membuka opsi View
Management. Di sini, Anda dapat melihat semua tampilan 3D proyek Anda. Jika Anda memiliki
perspektif yang telah ditetapkan, Anda dapat langsung beralih ke sana. Jika Anda tidak memiliki
pengaturan apa pun, klik tombol '‘Buat Tampilan' di bagian bawah tab View Management, dan Enscape
akan menyimpan posisi saat ini dan waktu siang hari di SketchUp.
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Dengan mengklik tombol edit, Anda dapat menandai tampilan 3D sebagai favorit untuk memudahkan
akses, atau Anda dapat menautkan prasetel pengaturan visual ke tampilan tersebut (sesuatu yang
akan kita bahas di bagian Pengaturan Visual).
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Dengan mengeklik '‘Buat Tampilan', Anda dapat membuat tampilan 3D baru di aplikasi desain Anda.
Enscape akan menyimpan perspektif dan waktu serta pengaturan lain yang disalin dari tampilan yang
saat ini dipilih. Anda dapat kembali ke tampilan yang dipilih kapan saja dengan menekan 0 pada papan
angka Anda. Ini sangat berguna jika Anda tersesat dan menyediakan titik aman untuk selalu kembali.

Untuk menutup Manajemen Tampilan, tekan Esc pada papan ketik Anda atau tombol beranda.

Pengaturan Visual
Anda dapat mengakses Pengaturan Visual dari jendela rendering Enscape:
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Visual Settings
Open the Enscape Visual Settings window

Di sinilah Anda dapat menyempurnakan tampilan visualisasi Enscape Anda, baik berupa gambar,
video, atau pengalaman realitas virtual. Anda mungkin menemukan diri Anda di sini saat Anda siap
mengekspor render dan ingin membuat tampilan tertentu atau jika Anda hanya ingin menguiji
berbagai pengaturan dan melihat bagaimana pengaruhnya terhadap visualisasi Anda.

Di Pengaturan Visual, Anda dapat mengatur kamera, lingkungan, dan pengaturan ekspor. Anda juga
dapat menentukan detail tertentu, seperti gaya render (misalnya, mode putih), kecerahan buatan dan
sekitar, serta kedalaman bidang. Anda dapat menyesuaikan pengaturan atmosfer, seperti kecerahan
matahari dan langit malam, ketajaman bayangan, mengubah intensitas angin, dan banyak lagi.
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Di tab Output, Anda dapat memilih resolusi render, format file (seperti .png), apakah akan
mengekspor lapisan render tambahan untuk pascaproduksi (seperti saluran alfa untuk gambar dengan
latar belakang kosong), kualitas kompresi video, dan banyak lagi.

Di sisi paling kiri jendela Pengaturan Visual, terdapat panah oranye kecil. Dengan mengekliknya, Anda
akan membuka panel samping yang menyimpan preset Pengaturan Visual Anda. Klik 'Buat Preset'
untuk menyiapkan preset baru. Sekarang Anda dapat memilih pengaturan yang sesuai dari tampilan
sebelah kanan dan mulai membuat tampilan tertentu untuk adegan Anda.
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Anda bahkan dapat menghubungkannya dengan tampilan Anda di jendela Manajemen Tampilan.
Semua pengaturan di antarmuka ini dapat dikontrol oleh preset.

Editor Material Enscape

Enscape dilengkapi dengan Material Library dan Material Editor miliknya sendiri. Di sini Anda dapat
menemukan berbagai material dan peta siap pakai. Anda juga dapat mengimpor material Anda sendiri
dan menggantinya dengan mudah.

Buka Enscape Material Editor dengan mengklik ikon bola kotak-kotak di bilah alat Enscape atau
dengan masuk ke SketchUp > Ekstensi > Enscape Materials.
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Anda akan melihat jendela yang menunjukkan material yang dipilih di sebelah kanan dan daftar semua
material dalam proyek Anda di sebelah kiri. Perhatikan bahwa Enscape Material Editor mengakses
material yang sama seperti SketchUp, dan Enscape menambahkan beberapa informasi dan fungsi.
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Anda menyiapkan dan menerapkan material di SketchUp, tetapi Anda dapat mengeditnya di Editor
Material Enscape. Di sini Anda dapat mengubah warna, tinggi (dengan peta tonjolan, normal, dan
perpindahan), dan pantulan, yang mengontrol seberapa mengilap objek akan terlihat.

Anda juga dapat mengimpor tekstur untuk membantu Anda menyiapkan material. Ada banyak situs
yang menyediakan tekstur 3D gratis berkualitas tinggi , seperti Poliigon.com atau ambientcg.com .
Lihat tutorial video ini pada menit ke-19:09 untuk mengetahui cara melakukannya.

Pembaruan dan penggantian material dari Enscape Material Library dapat dilakukan dari dalam
Enscape Material Editor. Ini membantu Anda melihat, menguji, dan mengubah material dalam model
Anda dengan cepat tanpa harus menggantinya satu per satu.

Pustaka Aset Enscape

Pustaka Aset Enscape menyediakan lebih dari 3.000 model berkualitas tinggi yang dioptimalkan secara
real-time bagi Anda untuk menyempurnakan pemandangan Anda, dan daftar itu terus bertambah
seiring seniman 3D kami menambahkan lebih banyak lagi pada setiap rilis.
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Anda dapat mengaksesnya melalui SketchUp atau melalui bilah alat Enscape dengan mengeklik ikon
pohon. Jika Anda membuka pustaka dari SketchUp — maka Anda hanya dapat menambahkan aset di
dalam SketchUp. Untuk menambahkan aset langsung ke adegan yang dirender melalui Enscape, Anda
perlu mengakses pustaka dari bilah alat Enscape.

Mudah digunakan — cukup pilih model apa saja, klik dengan tombol kiri tetikus, dan tempatkan di
SketchUp. Aset akan ditempatkan sebagai placeholder yang disederhanakan di SketchUp untuk
menghemat kinerja, dan Enscape akan menampilkan model lengkap dengan detail tinggi.

Aset offline

Secara default, pustaka aset 3D akan mengunduh aset berulang-ulang. Namun, Anda dapat
mengunduh versi offline pustaka dengan mencentang kotak 'Offline Enscape Assets' di sudut kanan
bawah agar dapat dimuat lebih cepat saat memulai.

Anda dapat menandai aset sebagai favorit dengan mengeklik ikon bintang. Ini akan menyimpannya di
folder favorit.




MODUL 12 - Rendering dengan Enscape

Aset khusus

Jika Anda memiliki model 3D kustom yang ingin digunakan sebagai aset Enscape, Anda dapat
mengimpornya dalam format obj, fbx, atau gltf di tab Aset Kustom. Untuk informasi lebih lanjut
tentang cara menggunakan aset kustom di Enscape, lihat artikel Basis Pengetahuan kami .

Penempatan aset dalam Enscape

Untuk membuka Asset Library di jendela render Enscape, klik ikon pohon pada bilah alat, atau tekan
tombol | pada papan ketik Anda. Ini akan membuka antarmuka yang mengakses aset Enscape yang
sama seperti Asset Library di aplikasi desain Anda, bahkan termasuk aset kustom apa pun yang
mungkin telah Anda tambahkan.

Di bagian atas, Anda akan menemukan bilah pencarian dan tombol kaca pembesar untuk
mengonfirmasi pencarian Anda. Di sebelahnya, kami memiliki tanda tak terhingga yang dapat Anda
klik untuk memfilter kategori umum dan aset favorit Anda serta ikon tag untuk mengakses berbagai
tag dan mempersempit pencarian Anda.

Setelah Anda memilih aset yang ingin Anda tempatkan di dalam pemandangan, klik aset tersebut
menggunakan tombol kiri tetikus dan pilih permukaan tempat aset tersebut akan ditempatkan di
visualisasi Enscape. Klik kiri lagi untuk mengonfirmasi penempatan. Anda akan melihat bahwa pada
awalnya, Anda hanya akan melihat representasi placeholder berwarna abu-abu dari aset yang telah
Anda tempatkan. Anda dapat terus menempatkan aset dan setelah selesai, klik 'Terapkan perubahan'
atau 'Buang semua' jika Anda berubah pikiran. Menerapkan perubahan akan memuat model kualitas
penuh dalam desain Enscape Anda, dan placeholder akan ditempatkan di proyek SketchUp Anda.

Sekarang, saat menjelajahi desain Anda di Enscape, Anda dapat dengan cepat menambahkan aset di
sana dan kemudian, daripada kembali ke SketchUp. Anda juga dapat memutar, mengubah skala, dan
menempatkan beberapa aset dengan mudah. Untuk informasi lebih lanjut tentang ini, lihat tutorial
video kami .
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Cara merender gambar di Enscape untuk SketchUp
Merender gambar di SketchUp sangat cepat dan mudah dilakukan saat Anda menggunakan Enscape.

Untuk merender gambar diam menggunakan Enscape, klik tombol Screenshot seperti yang
ditunjukkan di bawah ini, atau gunakan tombol pintas, Shift + F11. Enscape akan menanyakan di mana
Anda ingin menyimpan gambar dan akan segera merendernya. Selesai! Gambar Anda akan dirender
hanya dalam beberapa detik.

Enscape
e x
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Screenshot [Shift + F11]
Create a rendering of the current Enscape
view.
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Ada juga beberapa pengaturan tambahan yang dapat Anda pilih, termasuk:

Mengubah resolusi : Buka tab Pengaturan Visual (jika Anda tidak yakin resolusi mana yang akan
digunakan, gunakan resolusi default, Full HD). Jika Anda perlu mencetak dalam skala yang lebih besar,
pilih Ultra HD atau nilai yang lebih tinggi (perlu diingat bahwa ini bergantung pada memori yang tersedia
pada kartu grafis Anda).

Menyimpan ke lokasi default : Di tab Output, Anda dapat mengatur folder default jika Anda tidak ingin
diminta memilih lokasi setiap saat. Anda juga dapat memberi tahu Enscape untuk memberi nama hasil
render secara otomatis.

Mengekspor gambar tanpa latar belakang : Pilih png sebagai jenis berkas gambar, lalu aktifkan kotak
centang Terapkan Saluran Alfa. Sekarang setiap bagian latar belakang yang tidak tersembunyi di balik
geometri akan tampak transparan, sehingga Anda dapat dengan mudah menempatkan gambar pilihan
Anda di belakang hasil render dalam perangkat lunak 2D apa pun yang mendukung lapisan.

Pilihan pasca-pemrosesan lebih lanjut : Pilih untuk mengekspor Object-ID, Material-ID, dan Depth

Channel di tab Output.

Cara membuat panorama

Untuk membuat panorama 360 derajat, cukup pindahkan ke lokasi yang diinginkan dan tekan
tombol di bawah. Anda dapat memilih untuk membuat panorama mono atau stereo.
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Anda dapat memilih resolusi untuk panorama di tab Visual Settings Output.

Panorama disimpan di antarmuka Upload Management yang dapat Anda temukan di SketchUp. Di
sinilah Anda dapat mengunggah panorama ke cloud sehingga dapat diakses dari perangkat apa pun
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melalui browser. Anda juga dapat menyalin dan membagikan kode QR agar orang lain dapat melihat
panorama Anda dengan memindai kode QR.

Ada beberapa opsi tambahan setelah Anda masuk ke Enscape License Center, seperti membuat galeri
atau tur (lihat tur panorama yang telah kami buat inil).

Cara membuat video
Untuk melihat cara merender video di Enscape dan SketchUp, lihat tutorial langkah demi langkah ini:

Cara mengekspor exe standalone atau web standalone

Selain menggunakan Enscape untuk mengekspor gambar, panorama, dan video, Anda juga dapat
mengekspor pengalaman mandiri interaktif yang independen dan membagikannya secara gratis tanpa
pengguna akhir memerlukan lisensi untuk melihatnya.

Untuk mengubah visualisasi Enscape Anda menjadi pengalaman yang dapat dibagikan, cukup gunakan
tombol Exe di bawah ini. Ada dua jenis yang dapat dipilih - file mandiri Exe dan file mandiri web.
Keduanya sepenuhnya kompatibel dengan VR, yang berarti Anda dapat dengan cepat menciptakan
pengalaman realitas virtual .
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Dengan mengklik tombol web mandiri, Enscape akan segera mulai mengunggah adegan Enscape ke
cloud Anda, yang dapat dilihat di browser dari mana saja di dunia. Bagikan tautan dengan siapa saja
atau taruh di situs web Anda.

Jika Anda ingin berbagi visualisasi dengan seseorang menggunakan mesin yang memenuhi
persyaratan sistem kami, Anda dapat mengekspor salinan Enscape yang identik dengan mengklik
tombol mandiri Exe. Ini tidak akan lagi terhubung ke aplikasi desain Anda, jadi tidak ada pengeditan
yang memungkinkan pada saat ini.
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